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Disclaimer
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Deployment Planning

13

1. Given a target audience, create policies regarding acceptable use of software and hardware
13
2. Identify manufacturers of hardware that can physically secure Macintosh computers and
peripherals devices
13
3. Given a document of software and hardware-use policies, develop a plan to distribute the
policies to users
13
4. Describe the issue regarding disposal of electronic equipment including compliance with
local state and federal regulations, cost and the storage and transportation of potentially
hazardous material.
14
5. Given a list of equipment including computer and peripherals, calculate the equipment’s
total power required
14
6. Describe how a directory service system can be incorporated as part of a software
deployment to enforce usage policies

14

7. Given a hardware deployment plan, modify the plan to include details on how to physically
secure the hardware
15
8. Define the following terms: ampere, watt and click matrix

15

9. Given a plan for deployment of new hardware and list of hardware being replaced, modify
the deployment plan to include instructions on how to properly dispose of the obsolete
hardware
15
10. Describe physical security features built into Macintosh computers

15

11. Identify context-appropriate considerations to take to physically secure the hardware

15

12. What five primary technologies in Mac OS X can be used to enforce policies

16

13. Given technical specifications for a Macintosh computer, identify appropriate temperature
range for operation of the computer
16
14. Given a list of installed hardware and a list software to be deployed create a testing matrix
that covers the full range of installed hardware and software
16
15. List third-party solutions that can assist in testing images and packages prior to deployment
16
16. Given one or more servers connected to a network, select a testing method for optimizing
deployment server stream (bandwidth)
16
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17. Explain what a Service-Level Agreement is. Explain the role of a SLA in relationship to the
deployment of Mac OS Systems
17

Deploying Individual Items and Containers

18

18. Define the following terms: resource fork, Mac OS X file system metadata, bundle, package,
AppleDouble
18
19. Give one or more files and the command line interface, create a .zip archive of the files

18

20. Describe the issues in distributing files with Mac OS X file system metadata

18

21. Given Terminal and a .zip archive, list the contents of the archive

18

22. List at least two methods for distributing files with Mac OS X file system metadata through
mechanisms that don’t support file system metadata
18
23. Given an archived/zipped file and the CLI, retrieve the files from the archive

19

24. Describe the issues in distributing bundles files

19

25. Given an archived/zipped file and the Finder, retrieve the files from the archive

19

26. List methods for distributing bundled files to ensure that the bundle’s contents are kept
intact
19
27. Given a collection of files, Apple Remote desktop and a Mac OS X computer configured to
be managed by ARD, coup the files to the remote computer via Drag & Drop
19
28. Describe the pros and cons of using each of the following methods for distributing a single
file to a group of files
20
29. State the command-line utility appropriate to use for archiving files with Mac OS file system
metadata
21
30. Given a folder or files and Disk Utility, create a disk image containing the files

21

31. List the image formats available when using Disk Utility to create disk images in a Mac OS X
computer
21
32. Given a disk image and Disk Utility, resize the disk image so that additional files can be
added to the contents

21

33. Give a disk image and Disk Utility, convert a disk image of one type such as read-only, to
another, such as compressed
21
34. State the name of the CLI utility for manipulating and creating disk images

21

35. Given a disk image, modify the disk image to include a background image in the Finder
window that provides the user with information about the content (such instructions to
drag on application to the /Applications folder)
22
36. List the advantages of using disk images over .zip files

22
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37. Given a disk image modify the disk image to include a file system link to a location on the
user’s system, such as “/Applications”, to assist in the copy of files from the disk image to
the correct location on the user’s computer
22
38. List the advantages of using .zip files over disk images

22

39. Given a disk image, convert it to an internet enabled disk image

23

40. Describe how an internet-enabled disk image functions differently than other disk image
types
23
41. Given an extremely large disk image, segment the image so that it can be distributed as
multiple smaller files

23

42. Explain how a bundled sparse disk image functions differently than a standard sparse disk
image
23
43. Given a list of the types of disk images that are supported on a Max OS X system identify all
the image types that can be segmented
23

Deploying with Installation Packages
44. Define the following terms: installation package, metapackage, receipts

24
24

45. Describe the difference between the flat-file installation package format of Snow Leopard
and the bundled format used in the earlier versions of the OS
24
46. Describe the purpose and benefits of using installation packages for software distribution 24
47. State the versions of Mac OS X that support the new flat-file installation package

25

48. Given a list of files within an unflatten installation package, describe purposes of each of the
files
25
49. List three methods for distributing software via installation packages

25

50. Given one or more scripts and PackageMaker, create an installation package that executes
scripts but does not install files (a payload-free package)
25
51. List the types of scripts that can be added to an installation package

25

52. Given PackageMaker, create a SnapShot installation package of files that had been installed
or modified during a specific monitoring period
26
53. Describe when each type of installation script is run

26

54. List alternative third-party solutions for creating and modifying installation packages

26

55. Given the CLI and a flattened installation package expand the package to a directory

26

56. Given an installation package, extract specific files from a package without installing all of the
files in the package
26
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57. Describe the importance of installation package inspection prior to installation/distribution
27
58. List what files will be installed by an installation package

27

59. Describe the purpose and benefit of checksumming with respect to package installers

27

60. Given a receipt from a manually installed installation package list which files were installed
by a pre-made package
27
61. Describe how Mac OS X tracks the installation of installer packages

27

62. Explain how Apple Remote Desktop can be used to open installation packages on one or
more remote computers
27
63. Given an installation package and a Mac OS X computer, verify that the package properly
installs files and runs the package’s scripts
27
64. Given SSH, an installation package and a remote Mac OS X computer, install the package on
the remote computer
28
65. Given a Mac OS X computer, list the installation packages that have been installed in a Mac
OS X system
28
66. Explain the recommended format of an installation package’s identifier

28

67. Given the command-line interface and a Mac OS X file system, repair permission issues
caused by installation of an incorrectly-built installation package

28

68. Given a Mac OS X computer list the installation package receipts that are used in correcting
permissions
28
69. Define the term “installation action” as it applies to PackageMaker projects

28

70. Given a Mac OS X computer and the pkgutil command, remove receipt data associated
with an installed package
28
71. Given a flat package and Flat Package Editor, display the contents of the flat package

28

72. Given a PackageMaker project file and a list of minimum system requirements for the target
computers, configure the project so that the final installation project will only install its
contents on systems that meet the stated minimum requirements
29
73. Given a PackageMaker project, modify the project to include one or more installation
actions

Creating System Images

29

30

74. Given a deployment plan and a target audience, specify application and system configuration
requirements for a custom image
30
75. State which files should be removed from a system before imaging a pre-configured system
30
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76. Given a Mac OS X computer connected to the internet, list the currently available software
updates provided by Apple
31
77. State the minimum OS version that can be imaged using System Image Utility

31

78. Given an image to be applied to one or more hardware system with software installed,
identify applicable software updates that should be applied to the image

31

79. State the image sources that can be used by System Image Utility for creating images

31

80. Configure the main administration account so that it is not visible from standard user
accounts

31

81. Describe the underlying structure and format of Mac OS X Server’s management client
system (MCX)

31

82. Given a Macintosh computer with a new copy of Mac OS X installed configure the system
to either not play the startup video or play an alternative version
32
83. Given a Mac OS X computer bound to an Open Directory server, configure the desktop to
display a locked image embedded with the acceptable use policy
32
84. Describe how System Image Utility uses Automator actions to create images

32

85. Given a Mac OS X computer bound to an Open Directory server, configure the login
window to deploy an organization specific message such as an acceptable use notice

32

86. Describe the relationship between the inputs and outputs of Automator actions and how
actions are combined together to create a workflow
33
87. Describe how other Automator actions can be used to enhance the creation of a Network
Disk Image
33
88. Describe the features and benefits of Mac OS X Server’s managed preferences system

33

89. Given System Image Utility an image source and one or more installation packages, create
NeBoot or NetRestore image that includes the packages
33
90. Describe the features and benefits of Mac OS X Servers preferences manifests

33

91. Explain the alternative method to Disk Utility for create a cloned image of a Mac OS X

33

92. Describe how to determine the minimum version of Mac OS X that should be used to
create an image for a Macintosh computer

34

93. Given a disk image for a Mac OS X computer and Disk Utility, prepare the disk image for
deployment
34
94. Describe the two methodologies for creating a deployment system image

34

95. Given Terminal and a configured Mac OS Computer, create a disk image from a configured
system
34
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96. Compare the two methodologies for creating a deployment system image including the
benefits of each method

34

97. Given a disk image of a Mac OS X computer and Terminal prepare the disk image for
deployment

34

Deploying System Images

35

98. Describe how a NetBoot Image ID is used by the NetBoot service to provide load balancing
35
99. Given a Mac OS X computer with Boot Camp partition, list methods for creating an image
of the system
35
100.Given System Image Utility and an image source, create a System Image Utility project that
includes an Automator action to define system configuration settings
35
101.Given a disk image of a Mac OS X system, Disk Utility and a target computer, restore the
target computer with the given disk image
35
102.State the format of the asr command when used to multicast images across the network 35
103.Given a disk image of a Mac OS X system, Terminal and a target computer, restore the
target with the give disk image
35
104.Given a list of files contained within a network disk image, describe the purpose of each
file
36
105.Describe how Apple’s Custom Software Solutions (Apple CSS) service can be used to
deploy software on new Apple hardware

36

106.Explain how ASR can be used to restore multiple computers simultaneously across the
network
36
107.List what protocols can be used when restoring an image via the ‘Define NetRestore
Service’ Automator action

36

108.Given a network configuration, calculate the data rate and multicast IP address range values
to be used by ASR when restoring computers caress the network
37
109.State the network requirements for using the NetBoot service to boot Macintosh
computers

37

110.State the location on a server where NetBoot images should be stored so that they are
recognized by the NetBoot service
37
111.Given a Mac OS X Server computer and Server Admin, specify which network ports are
used by the NetBoot service
37
112.Describe how to configure NetBoot server and a network to allow the NetBoot service to
be accessed across subnets
37
113.Given a Mac OS X Server computer and Server Admin, specify which volumes are used by
the NetBoot service for the storage of images and client data
38
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114.Explain how and Automator workflow can be created in place of System Image Utility to
create a Mac OS X deployment image
38
115.Give a Mac OS X Server computer configure as a NetBoot server, a NetBoot image stored
on the server and Server Admin, configure the NetBoot service to allow the image to be
used by client computers
38
116.List third-party alternatives for system image creation and deployment, and the benefit of
each
38
117.Given Mac OS X Server computer configured as a NetBoot Server, a NetBoot image
stored on the server, Server Admin and a list of client computers, configure the NetBoot
service to restrict access for specified image to specified computers
38
118.List the methods for configuring Macintosh computers to boot from a network disk image
39
119.Given a NetBoot server and Server Admin, display the log file for the NetBoot service

39

120.Given a Mac OS X Server configured as a NetBoot server and server Admin, list the
addresses of computers currently booted using the NetBoot service

39

121.Given a client computer that is unable to boot properly from a NetBoot server apply the
troubleshooting techniques to troubleshoot the client computer and server
39

Postimaging Deployment Considerations
122.List the basic server settings that are established during initial server setup

40
40

123.Given Server Assistant and an external storage volume such as an hard drive or a keychain
drive, create a configuration file in the storage volume so that the file will be applied to a
computer after Mac OS X Server has been installed
40
124.Describe the method for automatically configuring a fresh install on Mac OS X Server
software

40

125.Given ARD and a remote Macintosh computer, configure the system settings on the
remote computer

40

126.State what file extension must be used in order for a file to be recognized as an auto server
setup file by Mac OS X Server
41
127.Given a collection of application serial numbers and a remote computer, configure the
applications on the remote computer with the given serial numbers

41

128.Describe how a file should be created to distribute a password to allow Mac OS X server
to access an encrypted Auto Server Setup file
41
129.Given one or more computers, apply system settings, such as static network values after a
system gas been installed
41
130.Define the valid storage locations for saving auto configuration files

41
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131.Given one or more remote computers create scripts to apply system configuration settings
and set machine variables after the remote computers have been images
41
132.List third-party solutions to configure multiple remote computers after they have been
imaged

42

133.Given the Terminal application and a property list editor on a default installation of Mac OS
X Server, create launchd item to launch a service on demand
42
134.List the conditions that can be set to restrict an auto server setup file to specific computers
in the order of precedence
42
135.Create a launchd item to launch as service at the regular interval

42

136.Explain the function of byhost preferences and identify which computers they apply to

42

137.Given launchctl on a default installation of Mac OS X Server, load a launchd job

42

138.Describe the underlying structure and format of Mac OS X Server’s property list
architecture

43

139.Given the ARD Admin application on a default installation of Mac OS X Server and an
inactive ARD client on a default installation of Mac OS X, configure the ARD client to
activate the ARD agent using the kickstart tool from a remote machine

43

140.List the tools included with Mac OS X that are capable of altering preferences lists files 43
141.Given a Mac OS X system and a script, configure the operating system to execute the
script every time a user logs in

43

142.Describe the purpose, features and benefits of launchd and launchctl

43

143.Create a script that uses the systemsetup command to configure general system settings
including date, time, computer name and energy settings
43
144.List the valid locations for storing launchd items in a standard installation of Mac OS X

44

145.Configure the network settings of the computer using the networksetup command

44

146.Enable ARD for a specific account using kickstart command

44

147.List the common triggers launchd “understands” by default for launching jobs

44

148.Configure computer settings using defaults

44

149.List the common keys included in a launchd property list

44

150.Explain what a “login hook” is

45

151.Identify which Mac OS X command-line utility is used to configure general system settings
45
152.Identify the Mac OS X command-line utility that is used to configure network settings in
SystemPreferences
45
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153.State which Mac OS X command-line utility is used to enable ARD Remote Management
for a specific local administrator account
45
154.Identify which Mac OS X command-line utility is the primary tool for reading and writing
directory system data
45
155.Identify which Mac OS X command-line utility should be used to bind a Mac OS X system
to an Active Directory service
45
156.Identify which Mac OS X command-line utility should be used to bind a Mc OS X system to
an LDAP service
45

System Maintenance

46

157.Given ARD and a number of Macintosh computers, configure ARD to monitor/track
hardware and software

46

158.List available license and software tracking systems

46

159.Define the following terms: Apple Remote Desktop, Task Server

46

160.Given a Mac OS X Server computer list all he currently available software updates
provided by Apple

46

161.State how to configure a router to prevent Mac OS X computers on the local network
from accessing and downloading updates from Apple’s update servers
46
162.State the default location where updates download from Apple are stored on a Software
Update server
46
163.State the preference file where you set the URL of the Software Update server to be
accessed for software updates

47

164.State what process on a Mac OS X Server computer is used to synchronize updates
between the server and Apple’s software update servers

47

165.Identify which process is used to provide the software update service on a Mac OS X
Server computer

47

166.State which file should be modified to reconfigure the Software Update service on one Mac
OS X Server to retrieve updates from a second Mac OS X Server computer
47
167.Set up a test Software Update Server to test distribution of updates provided by Apple
before enabling the updates on an organization’s primary software Update server
47
168.Given a Mac OS X computer and a Mac OS X Server computer that is running the
Software Update service, configure the preferences on the client computer to use the
specific software Update service to access available updates

47

169.Given a Mac OS X Server computer that is managing the preferences on one or more Mac
OS X computers and a Mac OS X Server computer that is running the Software Update
service, configure the client computers to use the given Software Update service to access
available updates
48
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170.Given a Mac OS X Server computer with the Software UPdate service not functioning
correctly troubleshoot the server so that the client computers are able to access and
download updates correctly

48

171.Given a Mac OS X Server computer, configure the Software Update service to identify and
download software updates provided by the Software Update service running on another
Mac OS X Server computer
49
172.Given ARD 3 application on a default installation of Mac OS X, configure an Apple Remote
Desktop task server
49
173.Given a deployment plan, modify the plan to incorporate steps to roll-back an update or
software release should issues be encountered
49
174.Given a description for a target audience, create a policy permitting image modification 49
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Deployment Planning
Given a target audience, create policies regarding acceptable use of software and hardware
1. The larger the member of deployed system, the more rules need to be in place to keep

problems under control.
2. Different types of users often require different usage policies.
3. Evaluate old policies for new deployments, technology changes and new features may not

be addressed by old policies.
4. Consider the following policy categories:
• Computer access: who has access to which computers.
• Software: which applications are required and allowed.
• Peripherals: which peripherals are allowed.
• Storage: storage permissions and usage quotas, user’s home folder location.
• Network access: which users and computers have access to the network resources, to

wireless networks, secure network via VPN connections.
Regulations regarding how to deal with rogue network activity.
• Shared network resources: file servers, internal websites, network printers, communication

systems.

Identify manufacturers of hardware that can physically secure Macintosh computers and
peripherals devices
1. Kensington, security locks.
2. Nobles, custom Mac locks for desktop tower Mac systems.
3. Bretford, security carts for Mac computers and iPods.

Given a document of software and hardware-use policies, develop a plan to distribute the
policies to users
1. Make users to sign a paper contract before they are allowed to use the computer equipment.
2. Users may agree to usage policy electronically:
• By a web page.
• Through the login window.
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Describe the issue regarding disposal of electronic equipment including compliance with local
state and federal regulations, cost and the storage and transportation of potentially
hazardous material.
1. Need to define a location to temporary sore the old hardware before it leaves your facility.
2. All local waste ore recycling services require special handling for any type of battery.
3. Computer equipment is highly toxic in traditional waste streams.
4. Computer equipment is highly desirable for recyclers that may give your organization some

money return.

Given a list of equipment including computer and peripherals, calculate the equipment’s total
power required
1. Test one of your new computer using a pass-through electric monitor.

You need to test the peak usage and averages.

2. Find the standard power usage of the equipment you are going to be using in your

deployment.
Power requirements are listed on the Apple website.

3. Calculate the number of amps required (watts ÷ volts = amps).
4. Calculate the power requirements of peripheral equipment.
5. Consider which outlets are tied into individual circuits.

Try to keep lightening in a diﬀerent circuit.
Keep conditioners on a separate circuit.

6. Try to use uninterruptible power supplies (UPS).
7. Every amp used to power the computing equipment should be matched by another amp

used to provide cooling.

Describe how a directory service system can be incorporated as part of a software
deployment to enforce usage policies

Directory service permits to manage:

1. User accounts all over the network.
2. Home folder management, support for:
• Network home folder.
• Synchronized home folder.
• External storage device.

3. Managed preferences through MCX Management Architecture.
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Given a hardware deployment plan, modify the plan to include details on how to physically
secure the hardware
1. Secure the location where your computers reside
• Doors locks.
• Alarm systems.
• Surveillance systems.
• Full-time lab attendant staﬀ.

2. Use physical security mechanisms:
• Locking mechanisms:
• Kensington security locks for portables.
• Nobles locks for tower Mac computers.
• Storage carts for portable computers and devices

Define the following terms: ampere, watt and click matrix
1. Ampere (amp): to measure electric current.
2. Watt: to measure the amount of power.
3. Click matrix: is a check list that includes all the configurations and tasks that must be

completed and validated before the system is deployed.

Given a plan for deployment of new hardware and list of hardware being replaced, modify the
deployment plan to include instructions on how to properly dispose of the obsolete hardware
1. Back up or transfer user data.
2. Securely erase data from computer hard drives.
3. Take inventory, required for both internal accounting and for records of whomever is

receiving your old computers.

4. Collect the equipment, and transport them to the disposal destination, usually handled by

the same staﬀ that delivers the new equipment.

5. Dispose of the old equipment, usually done by a specialized company.

Describe physical security features built into Macintosh computers
1. Kensington security slots on portable Macs.
2. Traditional locking mechanisms to restrict access to internal components on recent desktop

tower Mac systems.

Identify context-appropriate considerations to take to physically secure the hardware
1. Open environments like computer labs or conference areas need hardware security

measures.

2. Oﬃce environments and equipments rooms usually do not require more then locations

security measures.

3. Open labs may need full-time lab attendant staﬀ and/or security locks.
PAGE 15 OF 49
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What five primary technologies in Mac OS X can be used to enforce policies
1. User account management.
2. Home folder management.
3. File system permissions.
4. Authorization management.
5. Managed preferences.

Given technical specifications for a Macintosh computer, identify appropriate temperature
range for operation of the computer
1. 50° to 95° Fahrenheit.
2. 10° to 35° Celsius.

Given a list of installed hardware and a list software to be deployed create a testing matrix
that covers the full range of installed hardware and software
SOFTWARE

Software1

Software 2

Software 3

Computer1

V

X

V

Computer 2

V

X

V

Computer 3

X

V

V

Computer 4

X

V

X

Computer 5

X

V

X

COMPUTERS

List third-party solutions that can assist in testing images and packages prior to deployment
1. Command line automation via shell scripts.
2. Graphical automation via AppleScript and Automator.
3. Eggplant series of software via TestPlant.

Given one or more servers connected to a network, select a testing method for optimizing
deployment server stream (bandwidth)

Select a small amount of computer and run the deployment test to verify the amount of bandwidth
generated to have a rough idea of the bandwidth usage proportion for the deployment on the whole
network.
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Explain what a Service-Level Agreement is. Explain the role of a SLA in relationship to the
deployment of Mac OS Systems
1. A Service-Level Agreement is a document or contract that ensures that the resulting

technology solution meets agreed-upon expectations.
It specifies:
• What service is supported.
• Times.
• Locations.
• Costs.
• Performance.
• Responsibilities of the parties involved.

2. SLAs help define details such as the following:
• Services provided.
• Performance measures.
• Problem management.
• User (or client) duties.
• Warranties.
• Disaster recovery policies.
• Termination of agreement.
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Deploying Individual Items and Containers
Define the following terms: resource fork, Mac OS X file system metadata, bundle, package,
AppleDouble
1. Resource fork: it’s a separate piece of data that compose a file in HFS that contains file

system metadata.

2. Mac OS X file system metadata: is a part of the file system that includes additional attributes

of an item for extended features.

3. Bundle: is a normal folder that is used to group related resources in on locations. Usually

they are assigned with names similar to files (that include a period in the file name).
Usually bundles are composed by a hierarchical directory structure containing an executable
code and related resources.

4. Package: is a bundle with the bundle file attribute set to appear as a single opaque item in

the Finder.

5. AppleDouble: is the practice of splitting files when using Mac OS X to copy files to any

other third-party file system to separate the metadata to be store as a hidden file (when the
file system do not natively supports metadata).

Give one or more files and the command line interface, create a .zip archive of the files
1. $ zip new_archive.zip <list of files to be archived>
2. $ ditto -c -k src_directory ditto_archive.zip

Describe the issues in distributing files with Mac OS X file system metadata

File system metadata may be lost when files are copied using traditional methods between diﬀerent
systems:
1. Ownerships can be lost or modified.
2. HFS attributes may be stripped away.
3. AppleDouble may be generated.

Given Terminal and a .zip archive, list the contents of the archive
1. $ zip -sf <zip archive>
2. $ unzip -l <zip archive>

List at least two methods for distributing files with Mac OS X file system metadata through
mechanisms that don’t support file system metadata
1. Archive File deployment.
2. Disk Image deployment.
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Given an archived/zipped file and the CLI, retrieve the files from the archive
1. $ unzip <zip archive>
2. $ ditto -kx <zip archive> <destination directory>

Describe the issues in distributing bundles files
1. Bundles and packages are treated as normal folders by third-party systems and transfer

mechanisms.

2. In many cases the bundle-bit attribute will be stripped away.
3. The once-opaque package will appear as a folder in the Finder.
4. The package will prevent to open as intended.
5. It confuses users because they will see a folder instead of an application icon.
6. Possible accidental partial copies.

Given an archived/zipped file and the Finder, retrieve the files from the archive

Double click the archive to obtain an uncompressed folder named like the archive, containing the
files of the archive.
List methods for distributing bundled files to ensure that the bundle’s contents are kept
intact
1. Archive File deployment.
2. Disk Image deployment.

Given a collection of files, Apple Remote desktop and a Mac OS X computer configured to be
managed by ARD, coup the files to the remote computer via Drag & Drop
1. Open the Remote Desktop application.
2. From the computer list in the sidebar select the target Mac.
3. Click the “Control” button from the toolbar.
4. The target Mac’s screen will appear and there navigate to the intended destination folder.
5. From the Finder in the local Mac select the items you want to copy on the target Mac.
6. Drag & Drop the items to the intended destination on the target Mac’s screen.
7. Close the target Mac’s screen, the copy will proceed also if the screen is closed.
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Describe the pros and cons of using each of the following methods for distributing a single file
to a group of files
1. Drag & Drop:
• Pros:
• Doesn’t require any encoding or decoding.
• Doesn’t require any special tools or any system.
• Simple for inexperienced users.
• Cons:
• Mac OS X file elements may not be preserved if storing or transporting using third-

party mechanisms.

• Multiple items may not be transferred properly when using certain third-party

mechanisms, as related items may became separated and lost during the transfer.

2. Archive File deployment:
• Pros:
• Mac OS X file elements are retained if encoded and decoded using the correct tools.
• Multiple items contained in a single file that is easily transferable using any mechanism.
• Compressed format saves storage space and bandwidth.
• Uses zip or tar.gz format that can be decoded on nearly any system.
• Cons:
• Requires additional encoding and decoding steps.
• No file checksums to verify content.
• The Finder doesn’t support the creation of encrypted archives.
• The Finder doesn’t support modifying existing archives.

3. Disk Image deployment:
• Pros:
• Mac OS X file elements are always retained.
• Multiple items or even entire file systems can be contained in a single file that is easily

transferable using any mechanism.

• File checksum helps verifying content.
• Optional compressed format saves storage space and bandwidth.
• Optional encrypted format secures items from unauthorized access.
• Optional read/write format allows easy modification and expansion of disk image

contents.

• Variety of advanced deployment uses beyond simple items.
• Cons:
• Requires additional creation, mounting and copying steps.
• Host with third-party systems are not able to open the Mac OS X disk image format.
• Can be complex for inexperienced users.
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State the command-line utility appropriate to use for archiving files with Mac OS file system
metadata

”ditto”
Given a folder or files and Disk Utility, create a disk image containing the files
1. Select File > New > Disk Image from folder, from the application menu.
2. Choose the source folder.
3. Cohos the destination folder and a disk image file name.
4. Choose the appropriate settings (disk image characteristics preferred), Save.

List the image formats available when using Disk Utility to create disk images in a Mac OS X
computer
1. read/write disk images.
2. DVD/CD master.
3. Sparse disk image.
4. Sparse bundle disk image.

More formats are available via ”hdiutil” command-line tool
Given a disk image and Disk Utility, resize the disk image so that additional files can be added
to the contents
1. Select Images > Resize... from the application menu.
2. Select the read/write disk image to be resized.
3. Choose the new dimension and click Resize

Give a disk image and Disk Utility, convert a disk image of one type such as read-only, to
another, such as compressed
1. Select Images > Convert... from the application menu.
2. Select the source disk image.
3. Select the new image format you want to covert the disk image to, and click Save

State the name of the CLI utility for manipulating and creating disk images

”hdiutil”
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Given a disk image, modify the disk image to include a background image in the Finder
window that provides the user with information about the content (such instructions to drag
on application to the /Applications folder)
1. Mount the read/write disk image.
2. Right-click on the root of the disk image to make the contextual menu to appear.
3. Select ‘Show View Options’ from the contextual menu.
4. Select ‘Picture’ as Background option.
5. Drag & Drop the copied image on the image well.
6. Rename the image with a leading period ‘.’ so the file will be hidden in the Finder.
7. Close the ‘View Option’ menu, and close the window showing the disk image content so

the new view configuration will be saved.

List the advantages of using disk images over .zip files

Disk images are ideal if you need to deploy:

1. Any number of items from simple to complex.
2. Entire operating systems.
3. The content of an entire file system or even multiple file systems.

Disk images are also preferred if your environment requires:
1. A storage mechanism that is easily editable.
2. A storage mechanism where compression is optional but not required.
3. Data checksum to verify the integrity of deployed items.
4. Increased security through the use of password-protected and encrypted storage.

Given a disk image modify the disk image to include a file system link to a location on the
user’s system, such as “/Applications”, to assist in the copy of files from the disk image to the
correct location on the user’s computer
1. Mount and open the read/write disk image.
2. In the Finder on the local computer browse to the directory you want to create the link to.
3. Drag & drop the directory to the disk image root (or any other contained destination)

holding the key combination of command + option.
List the advantages of using .zip files over disk images

Archive files are ideal if you need to deploy:
1. A small number of items.
2. On both Mac OS X and third-party operating system.

Archives files are also preferred if your environment requires:
1. A file format that is easily accessible for novice users to store items.
2. Quick lossless compression.
3. A file format that is compatible with nearly any operating system.
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Given a disk image, convert it to an internet enabled disk image

$ hdiutil internet-enable <disk image name>
Describe how an internet-enabled disk image functions differently than other disk image
types
1. When downloaded the internet-enabled disk image is automatically mounted.
2. The visible content is copied on the same folder containing the disk image.
3. The volume is ejected.
4. The disk image is placed in the trash.

Given an extremely large disk image, segment the image so that it can be distributed as
multiple smaller files

$ hdiutil segment -o <new_disk_image_files> [-segmentSize <size> |
-segmentCount <count>] <larg_disk_image_path>
Explain how a bundled sparse disk image functions differently than a standard sparse disk
image
1. Bundled disk image files are automatically sized to fit the disk image content.
2. Bundled disk images are saved as a package containing multiple storage bands.
3. Storage bands default size is 8MB, up to 128MB.
4. As the disk image contents expand, new bands are added.
5. Bundled disk image is the format used for FileVault and Time Machine.

Given a list of the types of disk images that are supported on a Max OS X system identify all
the image types that can be segmented

You can segment only read-only and compressed disk images
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Deploying with Installation Packages
Define the following terms: installation package, metapackage, receipts
1. Installation package: it’s a collection of compressed files and other information used to install

software on Mac OS X. The entire contents of an installation package are contained within
a single package bundle or package file, which has filename extension .pkg.

2. Metapackage: allows you to present multiple packages as a single installation package.

It references other installation packages which perform the actual installation. It has .mpkg
file extension.
3. Receipts: are items used to keep track of installation items.

Generally there are two receipts files:
• BOM, Bill Of Materials.

• plist, a file containing general information about an installation.

4. Payload: are the items intended to deploy using an installation package. The payload is

contained in the Archive.pax.gz file.

Describe the difference between the flat-file installation package format of Snow Leopard and
the bundled format used in the earlier versions of the OS
FLAT-FILE

BUNDLED

• Package content is flattened to a single

• Package content is in a bundled folder with

• Signable with a certificate.

• Not signable unless encapsulated in a disk

contiguous data file.

• Items stored in the root of the package.

the bundle flag active.

archive or compressed package.

• Has a package folder to contain the

package items.

CONTAINS

CONTAINS

• BOM

• Archive.bom

• Payload

• Archive.pax.gz

• Distribution

• Distribution

• PackageInfo

• Info.plist

• Resources folder

• Resources folder

Describe the purpose and benefits of using installation packages for software distribution
1. Verify that certain version of the operating system is already installed.
2. Verify that certain components are already installed on the system.
3. Start and stop processes ad daemons.
4. Install software in multiple locations throughout the system.
5. Run custom scripts to automate administrative functions.
6. Present the users with documentation, policies or license information.
7. Allow the user to customize the installation.
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State the versions of Mac OS X that support the new flat-file installation package

Mac OS X 10.5 or superior
Given a list of files within an unflatten installation package, describe purposes of each of the
files
1. BOM: (Bill Of Materials) describes the contents of the installation package.
2. Payload: contains the actual content to be installed.
3. Distribution: script file to control the installation process, like Installer interface

customization and installation requirements specification.

4. PackageInfo: property list which contains general installation information, such as whether

the package requires the computer to be rebooted after installation.

5. Resources folder: contains additional resources that are used by the installation process such

a background image, ReadMe files, license-agreement files.

6. Packages folder (only for bundle-based metapackages).

List three methods for distributing software via installation packages
1. Web server, or file server.
2. SSH.
3. ARD.
4. Third-party and commercial softwares.

Given one or more scripts and PackageMaker, create an installation package that executes
scripts but does not install files (a payload-free package)
1. Drag an empty folder to the Contents list.
2. Disable the Empty folder to install (from the Contents pane).
3. Configure the actions and scripts.

It’s best practice to set postinstall actions and scripts for payload-free installations so the scripts run
only if the user chooses to complete the installation process.
List the types of scripts that can be added to an installation package
Flat packages

Bundle-base packages

Preflight
Preinstall

Preinstall
Preupgrade

Postinstall

Postinstall
Postupgrade
Postflight
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Given PackageMaker, create a SnapShot installation package of files that had been installed
or modified during a specific monitoring period
1. Select Project > Add Snapshot Package from the application menu.
2. Click the “Start” button to begin the ‘watching” session.
3. Perform the software installation and any other configuration you want to be part of the

package.

4. Check the ‘Stop’ button to end the ‘watching’ session and a new ‘Choice’ called ‘Snapshot’

will appear in the ‘Contents’ list.

5. Now proceed with the configuration of the package like it was a classic package.

Describe when each type of installation script is run
1. Preflight (BB only): run before all other scripts, before any upgrade take place.
2. Preinstall: run after the preflight script only if it’s a new installation.

In flat packages they run before the package they are associated to is installed.

3. Preupgrade (BB only): run after the preflight scripts only if the installation is an upgrade.
4. Postinstall: run after the initial installation.

In flat packages they run after the associated package is installed.

5. Postupgrade (BB only): run after an upgrade installation.
6. Postflight (BB only): run after all other scripts.

List alternative third-party solutions for creating and modifying installation packages
1. Pacifist by CharlesSoft.
2. Composer by JAMF.
3. Iceberg by WhiteBox.
4. InstallEase from LANrev management suite.
5. VISE X 3 by Mind Vision.

Given the CLI and a flattened installation package expand the package to a directory

$ pkgutil --expand FlatInstallation.pkg <UnFlatInstallFolder>
Given an installation package, extract specific files from a package without installing all of the
files in the package
1. Unflatten the flat package or locate and extract the payload archive of a bundle-based

package, to a temporary directory.

2. Select manually the items you are interested in, and copy them in your favorite location.
3. Assign permissions to those items manually according to the BOM file included in the

package.
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Describe the importance of installation package inspection prior to installation/distribution
1. A poorly made installation package could destroy the software on your Mac.
2. A malicious installation package could perform an action that puts your personal

information at risk or even violate the low.

List what files will be installed by an installation package

$ lsboom -p MUGsf /Path/Of/Installation/Package/BOM_File
Describe the purpose and benefit of checksumming with respect to package installers
1. It’s used to verify that the download file is identical to the original.
2. It prevents you to install compromised packages due to connection failure or sabotage.

Given a receipt from a manually installed installation package list which files were installed by
a pre-made package
1. Navigate to /var/db/receipts folder, in Mac OS X 10.6, to view the list of .bom files.

Prior to Mac OS X 10.6 .bom files are stored in /Library/Receipts/db folder.
2. Use the command:

$ lsbom -p MUGsf <bomfile.bom>
Describe how Mac OS X tracks the installation of installer packages

Immediately after an installation completes, a receipt entry is created for the installation package.
Two files are generated, a ‘.bom’ (Bill Of Materials) file that contains the list of installed files, and a
‘.plist’ (Preferences List) file that contains general installation information (including when the item
was installed).
Explain how Apple Remote Desktop can be used to open installation packages on one or
more remote computers
1. Open the ‘Remote Desktop’ application.
2. Select the computers to which you want to deploy into the packages list.
3. Click the ‘Install’ button.
4. Configure the deployment conditions and schedule time for the deployment.
5. Click ‘Install’.

Given an installation package and a Mac OS X computer, verify that the package properly
installs files and runs the package’s scripts
1. The Installer application will present an ‘Install Succeeded” screen.
2. The installer CLI command will return “installer: The install was

successful”.
3. The ARD application will report ‘Succeeded’ in the History list.

Any installation will write information on “/var/log/install.log’ that you can consult with
the CLI toll less or the Console application.
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Given SSH, an installation package and a remote Mac OS X computer, install the package on
the remote computer

Working on the local computer:
1. $ scp package.pkg ladmin@remotemac.local:/tmp/
2. $ ssh ladmin@remotemac.local
3. remotemac$ cd /tmp/
4. remotemac$ sudo installer -pkg /tmp/package.pkg -target /

Given a Mac OS X computer, list the installation packages that have been installed in a Mac
OS X system

$ pkgutil --pkgs
Explain the recommended format of an installation package’s identifier

The format is the reverse URL notation like org.mozilla.firefox.
Given the command-line interface and a Mac OS X file system, repair permission issues
caused by installation of an incorrectly-built installation package

$ diskutil repairpermissions <path_to_the_target_volume_root (“/”)>
Given a Mac OS X computer list the installation package receipts that are used in correcting
permissions

$ /usr/libexec/repair_packages --list-standard-pkgs

Define the term “installation action” as it applies to PackageMaker projects
1. Actions (and Scripts) allow an installation package to serve as a deployment mechanism for

both files and administrative tasks.

2. Installation actions are very similar to the Automator actions and they can be part of an

installation workflow.

3. You can set action for the installation product package ONLY, not per choice or package.

Given a Mac OS X computer and the pkgutil command, remove receipt data associated with
an installed package

$ sudo pkgutil --forget org.mozilla.forget --volume /

Given a flat package and Flat Package Editor, display the contents of the flat package
1. Right-click on the flat-package icon.
2. Select Open With > Flat Package Editor
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Given a PackageMaker project file and a list of minimum system requirements for the target
computers, configure the project so that the final installation project will only install its
contents on systems that meet the stated minimum requirements
1. You can set installation requirements that prevent the whole package to install if not met,

selecting the Product Package and the Requirements pane where you can set up the
conditions.

2. You can set installation requirements that prevent the installation of specific package choice

selecting the choice from the Contents list and accessing the Requirements pane where you
can setup the conditions.

Given a PackageMaker project, modify the project to include one or more installation actions
1. Select the product package title above the Contents list.
2. Click the Action tab.
3. Click the Edit button below either the Preinstall Actions list or the Postinstall Actions list.
4. A new dialog appears allowing you to create an installation action workflow.
5. Drag the desired actions from the actions list to the workflow area.
6. Configure the action inputs and click ‘Save’.
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Creating System Images
Given a deployment plan and a target audience, specify application and system configuration
requirements for a custom image
1. You need to use the latest retail version of Mac OS X to be sure that the image is compatible

with all the computers that respect the minimum requirements and all new Macs.
Intermediate versions of Mac OS X shipped with the latest Macs may not have support for
older computers.

2. You need to acquire and apply the latest Apple System updates to the image so you have not

to repeat it for every single computer.

3. Check the latest version of third-party software and drivers.

State which files should be removed from a system before imaging a pre-configured system
1. Remove user-specific files:
• /Volumes/HD/Users/<username>/Send\ Registration
• /Volumes/HD/Users/<username>/Desktop/*
• /Volumes/HD/Users/<username>/Downloads/*
• /Volumes/HD/Users/<username>/Library/Caches/*

2. Remove computer-specific files:
• /Volumes/HD/Documentation/old_*
• /Volumes/HD/Library/Caches/*
• /Volumes/HD/System/Library/Caches/*
• /Volumes/HD/Library/Managed\ Preferences/*
• /Volumes/HD/Users/Shared/*
• /Volumes/HD/private/etc/ssh_host*
• /Volumes/HD/private/var/db/volinfo.database
• /Volumes/HD/private/var/vm/swap*
• /Volumes/HD/private/var/vm/sleepimage

3. Reset the LKDC (Local Kerberos Distribution Center):
• /Volumes/HD/private/var/db/.configureLocalKDC
• /Volumes/HD/private/var/db/krb5kdc
• /Volumes/HD/private/etc/krb5.keytab
• /Volumes/HD/Library/Keychains/System.keychain
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Given a Mac OS X computer connected to the internet, list the currently available software
updates provided by Apple
1. Launch the Software Update application.
2. Go to www.apple.com/downloads.

State the minimum OS version that can be imaged using System Image Utility

Mac OS X 10.6
Given an image to be applied to one or more hardware system with software installed,
identify applicable software updates that should be applied to the image

Install Combo Updates as they include system security updates too

State the image sources that can be used by System Image Utility for creating images
1. Mac OS X installation media.
2. Any System Volume that is not currently booted (also in for of a mounted disk image

volume).

Configure the main administration account so that it is not visible from standard user
accounts
1. Login to the model computer with an administrative account.
2. Choose ‘Display login window as:’, ‘list of users’ from the Login Options from the Account

Preferences pane of System Preferences.

3. Create a new administrative account (do not activate FileVault for it).
4. Choose the advanced option for the new administrative account and assign it the user ID

499 and change the home directory location to any hidden path like ‘/var/.hadmin/’.
5. Move the original home folder to the new path and correct the ownership for the home

folder items.

6. Remove the Public and Sites folders from the hidden administrator home folder.
7. Modify the loginwindow settings so the hidden administrator account and any account

with user ID below 500 are not shown:
• $ sudo defaults write /Library/Preferences/

com.apple.loginwindow Hide500Users -bool TRUE
• $ sudo defaults write /Library/Preferences/

com.apple.loginwindow HiddenUsersLists -array hadmin
8. Delete your initial administrator account because it’s not hidden.

Describe the underlying structure and format of Mac OS X Server’s management client
system (MCX)

It’s XML
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Given a Macintosh computer with a new copy of Mac OS X installed configure the system to
either not play the startup video or play an alternative version
1. Create a .mov (video) and .mp3 (audio) files, optionally empty.
2. Copy those files into “/System/Library/CoreServices/Setup

Assistant.app/Contents/Resources/TransationSection.bundle/
Contents/Resources”
Given a Mac OS X computer bound to an Open Directory server, configure the desktop to
display a locked image embedded with the acceptable use policy
1. Create the image you want to use as locked desktop.
2. Login into your model computer with and administrative account.
3. Place the image in a location that all users will be able to access “/Library/Desktop

Pictures”.
4. Open the Desktop & Screen Saver preferences and set the desktop background.

Set also additional desktop background features.

5. Protect the desktop image file from modification (755, chown root:wheel).
6. Open Workgroup Manager (WGM).
7. Select the accounts you want to manage.
8. Click the Preferences button from the toolbar and select the Details tab.
9. Click the ‘+’ button to activate the import dialog.
10. Select the file ‘~/Library/Preferences/com.apple.desktop.plist’.
11. Double-click the Desktop Picture preferences.
12. Select and delete al the items except for

Background > Default Image > Image Path
Describe how System Image Utility uses Automator actions to create images
1. Included with SIU is a suite of Automator actions tailored o the creation of custom network

disk images.

2. The Customize button will reveal the workflow mode of SIU where the actions ‘Define

Image Source’ and ‘Create Image’ are always in place and have always to be respectively the
first and last actions if any workflow in SIU.

Given a Mac OS X computer bound to an Open Directory server, configure the login window
to deploy an organization specific message such as an acceptable use notice
1. Open WGM.
2. Select the computers accounts or groups you want to modify the login screen for.
3. Click the Preferences button from the toolbar.
4. Click the Login Preferences button.
5. Select the ‘Manage’, ‘Always’ tab.
6. Define the ‘Message’ you want to display, click ‘Done’.
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Describe the relationship between the inputs and outputs of Automator actions and how
actions are combined together to create a workflow

Adjacent actions can communicate to one another through inputs and outputs.
Describe how other Automator actions can be used to enhance the creation of a Network
Disk Image

You can use SIU specific actions directly in the Automator application.
In this case you have access to all the automator actions available in your system and you can create
more advanced workflows to personalize your Network Disk Image.
Describe the features and benefits of Mac OS X Server’s managed preferences system
1. You can choose to display managed preferences after you have deployed your system image.
2. The managed preferences service is a network directory service that the client computers are

bound to.

3. You don’t have to include configuration information as part of your system image.
4. You can easily change configuration settings after your initial deployment.
5. Define policy at four diﬀerent account levels: user, group, computer, computer groups.
6. The management remains active even if the Mac is disconnected from the directory service

(preferences are cached locally).

Given System Image Utility an image source and one or more installation packages, create
NeBoot or NetRestore image that includes the packages
1. Click the ‘add’ (‘+’) button, to ‘Create a New Workflow’, click ‘Agree’.
2. Drag & drop the action ‘Add packages and Post-Install Script’ between the actions ‘Define

Image Source’ and ‘ Create Image’.

3. Drag & drop the installation packages you want to install in the new action.
4. Select NetBoot or NetRestore as image type in the ‘Create Image’ action.
5. Click ‘Save’ to save the workflow, and then ‘Run’ to create the image.

Describe the features and benefits of Mac OS X Servers preferences manifests
1. It is a file embedded inside an application bundle that describes the application’s

customizable preferences.

2. It often includes examples and plain-text description of the items.
3. WGM first scans the application looking for a manifest file.

Explain the alternative method to Disk Utility for create a cloned image of a Mac OS X
1. You can use the hdiutil CLI command.
2. You can use System Image Utility that brings the advantages of an automated method for

creating deployable system images.

PAGE 33 OF 49

APPLE CERTIFIED SPECIALIST - DEPLOYMENT V10.6

MARCO AT MARCOMC DOT COM

Describe how to determine the minimum version of Mac OS X that should be used to create
an image for a Macintosh computer

Consult the Apple article HT1159 “Mac OS X versions (builds) included with Intel-based Macs” to
determine the minimum version of Mac OS X that includes hardware support of a specific Mac
model.
Given a disk image for a Mac OS X computer and Disk Utility, prepare the disk image for
deployment
1. Choose Images > Scan Image for Restore.
2. Alternatively use the CLI command asr as follow:

$sudo asr imagescan --source cloned_image.dmg
Describe the two methodologies for creating a deployment system image
1. Creating an image of a completely configured system:

You create a cloned disk image an existing and configured system and prepare if for
deployment removing specific files as the system has already been booted at least one time.

2. Applying installation packages to a base OS image:

You create a Network Disk Image based on a new installation through a SIU (Automator)
workflow that install applications and applies configurations with the use of personalized
installation packages, in this case is not necessary to delete any file from the final image as the
system is never booted before the deployment.

Given Terminal and a configured Mac OS Computer, create a disk image from a configured
system
1. $ sudo hdiutil create -srcdevice /Volume/<mounted System

Volume> output.dmg
2. $ sudo asr imagescan --source output.dmg

(to prepare the image for deployment)

Compare the two methodologies for creating a deployment system image including the
benefits of each method
1. Basic Images with System Image Utility:
• Similar to when you create a cloned system image.
• Created by setting up a model computer.

2. Modular Image:
• Cleaner system image.
• Easier upgrade path.
• Easy to automate.
• Built by applying multiple installation packages.

Given a disk image of a Mac OS X computer and Terminal prepare the disk image for
deployment

$ sudo asr imagescan --source disk_image.dmg
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Deploying System Images
Describe how a NetBoot Image ID is used by the NetBoot service to provide load balancing
1. The image ID is an index value which the client computers use to identify images hosted

from NetBoot shares.

2. If multiple hosted images have the same index number, client assumes that the images are

identical and displays only one entry.

3. The Client will attempt to connect the the least busy NetBoot server to get the best

performance.

4. If a network disk image will be hosted on only a single server, it should be assigned an index

value between 1and 4095.
Given a Mac OS X computer with Boot Camp partition, list methods for creating an image of
the system

Use WinClone (third-party software) as Mac OS X doesn’t include any built-in support for creating
system images of a Mac Boot Camp partition containing the Windows operating system.
Include the WinClone dmg image as file inside a Mac OS X NetBoot disk image.
Try to restore a WinClone dmg image using scripts included in a ‘.pkg.’ package in a modular
NetBoot image.
Given System Image Utility and an image source, create a System Image Utility project that
includes an Automator action to define system configuration settings
1. Click the ‘add’ (‘+’) button to create a New Workflow.
2. Drag & drop the ‘Apply System Configuration Settings’ action just before the ‘Create

Image’ action.

Given a disk image of a Mac OS X system, Disk Utility and a target computer, restore the
target computer with the given disk image
1. Start the target computer in ‘Target’ mode and connect it to your computer via FireWire.
2. In Disk Utility select Volume corresponding to the target computer startup volume.
3. Click the ‘restore’ tab.
4. Drag & drop the disk image in the ‘Source’ field.
5. Drag & drop the target computer volume in the ‘Destination’ field, click ‘Restore’.

State the format of the asr command when used to multicast images across the network

$ sudo asr --server “Documents/asrconfig.plist” --source “/
Volumes/Storage/Image.dmg”
Given a disk image of a Mac OS X system, Terminal and a target computer, restore the
target with the give disk image

$ sudo asr restore --source diskimage.dmg -target “/Volumes/
Target_Volume” --erase
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Given a list of files contained within a network disk image, describe the purpose of each file
1. NBImageInfo.plist: contains most of the configuration settings.
2. NetBoot.dmg/NetInstall.dmg: read/write disk image containing the full system volume.
3. A folder named “i386”: contains the fundamental core system files required to initiate the

Mac OS X startup process in Intel-based Macs.
Contains:
• System Boot Loader ‘booter’.
• 32-bit Mac OS X kernel ‘mach.macosx’.
• 32-bit driver cache ‘mach.macosx.mkext’.

• A folder named ‘x86_64’ that contains similar items for booting in 64-bit kernel mode.

4. A folder named ‘ppc’ (only in older network disk images): contains the fundamental core

system files required to initiate Mac OS X startup process on PowerPC-base Macs.

Describe how Apple’s Custom Software Solutions (Apple CSS) service can be used to deploy
software on new Apple hardware
1. The Apple CSS team can:
• Deploy a customer’s system image to new Macs at the factory.
• Apply customer’s asset tags at the factory and provide an asset report upon delivery.

2. For orders between 75 and 200 units the customer’s submitted images are accepted.
3. For orders of more then 200 units the CSS team will work with the customer to create a

modular system image deployment solution. This software components are chosen using a
dedicated website portal.

Explain how ASR can be used to restore multiple computers simultaneously across the
network
1. ASR system transmit the disk image data via a multicast network protocol, broadcasting the

disk image data to the network in continuous loop.

2. Other Macs on the network can ‘hook in’ to this data stream and start restoring to load

volume.

3. You can use ARD to kick oﬀ the restore process at the exact time on all the deployed

systems.

List what protocols can be used when restoring an image via the ‘Define NetRestore Service’
Automator action
1. ASR.
2. http.
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Given a network configuration, calculate the data rate and multicast IP address range values
to be used by ASR when restoring computers caress the network
1. Data Rate:
• Expressed in bytes per second. Variables to takes in consideration include:
• Network speed.
• Other network traﬃc.
• Computer processor speed.
• Destination drive speed.
• Successful data rates between 2 Mbit/s and 20 Mbits,

start testing from 6 Mbit/s on 100 Mbit networks,
start testing from 12 Mbit/s on 1 Gbit networks.
2. Multicast Address:
• Anywhere between 224.0.0.0 and 239.255.255.255.
• ASR should always run on an isolated and dedicated subnet.

State the network requirements for using the NetBoot service to boot Macintosh computers
1. 100 Base-T Ethernet (Mac clients).
2. Apple USB Ethernet or built-in Airport (Mac Book Air only).
3. 100 Base-T switched networking for deployments between 10 or 50 clients.
4. 1 Gbit Ethernet is required to use the NetBoot service with 50 or more clients.

State the location on a server where NetBoot images should be stored so that they are
recognized by the NetBoot service

/Library/NetBoot/NetBootSPn
Given a Mac OS X Server computer and Server Admin, specify which network ports are used
by the NetBoot service
1. UDP port 67 for DHCP protocol.
2. UDP port 67 for BSDP protocol.
3. UDP port 69 fro TFTP protocol.
4. TCP port 80 for http protocol.
5. Various TCP/UDP ports for NFS protocol.

Describe how to configure NetBoot server and a network to allow the NetBoot service to be
accessed across subnets

You need to forward BSDP broadcast traﬃc between subnets, that is the same configuration for
using DHCP across your network
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Given a Mac OS X Server computer and Server Admin, specify which volumes are used by
the NetBoot service for the storage of images and client data
1. Select the ‘NetBoot’ service from the list.
2. Click the ‘Settings’ button.
3. Select the ‘General’ pane button.
4. In the ‘Volumes’ list check the boxes to define where to store images and client data.

Explain how and Automator workflow can be created in place of System Image Utility to
create a Mac OS X deployment image

You can use Automator application to create a more complex workflow that generate a NetBoot
image as the System Image Utility action are also available in the Automator Library inside the
‘System’ collection.
Give a Mac OS X Server computer configure as a NetBoot server, a NetBoot image stored
on the server and Server Admin, configure the NetBoot service to allow the image to be used
by client computers
1. Select the ‘NetBoot’ service from the list.
2. Click the ‘Settings’ button.
3. Select the ‘Images’ pane button.
4. In the list of available images click the ‘Enable’ box of the images to make it usable by client

computers, then click ‘Save’.

List third-party alternatives for system image creation and deployment, and the benefit of
each
1. Deploy Studio, includes NetBoot, installation and ASR, tools for highly customizable

deployment workflows.
Supports BootCamp and Windows on standard PC systems.

2. InstaDMG is a series of reference UNIX scripts and documentation that will help to

automate the modular system image build process.

3. PKGImage is a graphical modular system image build tool that is based on AppleScripts.
4. PSU Blast Image Config optimized system deployment tool that leverage ASR.
5. WinClone can create deployable bottom system images.

Given Mac OS X Server computer configured as a NetBoot Server, a NetBoot image stored
on the server, Server Admin and a list of client computers, configure the NetBoot service to
restrict access for specified image to specified computers
1. Select the ‘NetBoot’ service from the list.
2. Click the ‘Settings’ button.
3. Click the ‘Images’ pane button.
4. Double-click the image you want to configure the filters for.
5. Choose to filter by Model Property or Mac Address
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List the methods for configuring Macintosh computers to boot from a network disk image
1. Startup pane of System Preferences (to select a specific NetBoot image).
2. Holding the ‘N’ key at boot time (Option-N to use the default NetBoot image instead of

the last use NetBoot image).

3. Holding the ‘Option’ key at boot time to start the Startup Manager.

Given a NetBoot server and Server Admin, display the log file for the NetBoot service
1. Select the ‘NetBoot’ service from the list.
2. Click the ‘Log’ button to display the /var/log/system.log filtered by ‘bootpd’

messages.

Given a Mac OS X Server configured as a NetBoot server and server Admin, list the
addresses of computers currently booted using the NetBoot service
1. Select the ‘NetBoot’ service from the list.
2. Click the ‘Connections’ pane button.

Given a client computer that is unable to boot properly from a NetBoot server apply the
troubleshooting techniques to troubleshoot the client computer and server
1. Rule to the network:
• Verify that the computer can receive DHCP information.
• Verify that you can see the network disk volumes from Startup Disk preferences.

2. Verify if you have a firmware password enable (pressing the Option key at start up) because

it will prevent the computer to NetBoot pressing the ‘N’ Key.

3. Check the disk space on the server.
4. Check the NetBoot service filters.
5. Check your server firewall configuration: NetBoot service requires:
• BSDP/DHCP
• TFTP
• NFS
• AFP
• HTTP

6. Check the /var/log/system.log for ‘bootp’ messages.
7. Stop and restart the bootpd daemon.
8. Check the NetBoot configuration /etc/bootpd.plist.
9. Move or delete the DHCP and NetBoot cache files in

/var/db/dhcp_clients and /var/db/bsdpd_clients
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Postimaging Deployment Considerations
List the basic server settings that are established during initial server setup
1. Server System language and keyboard layout.
2. Mac OS X Server serial number and license information.
3. Time zone and network time.
4. Local administrator account configuration.
5. Network configuration and network naming.
6. Users and Groups configuration.
7. OPTIONAL - Connect to a directory service.
8. OPTIONAL - Configure an Open Directory Master.
9. OPTIONAL - Initial setup of services including File Sharing, Address Book, Calendar,

Instant Messaging, Mail and Web.

Given Server Assistant and an external storage volume such as an hard drive or a keychain
drive, create a configuration file in the storage volume so that the file will be applied to a
computer after Mac OS X Server has been installed
1. Start Server Assistant.
2. Complete each setup screen that appears by entering the appropriate server information for

your server.

3. When you arrive at the Server Configuration screen select the encryption option for the pop-

up menu.

4. Optionally set restrictions for this configuration selecting the check box and clicking the

‘Edit’ button.

5. Click the ‘Save’ button to name and place the file (configuration.plist).
6. Place the file in a folder named ‘Auto Server Setup’ on the root of the storage volume.

Describe the method for automatically configuring a fresh install on Mac OS X Server
software
1. You need to create a configuration ‘.plist’ file with Server Assistant.
2. Place this file in a folder named ‘Auto Server Setup’ placed in the root of any of the volumes

available during the new system setup process (first boot).

3. You can protect the configuration file using password encryption. You will be requested to

enter the password before start the configuration or you can place a ‘.pass’ file containing the
encryption password (in plain format) with a name matching the configuration file name.

Given ARD and a remote Macintosh computer, configure the system settings on the remote
computer
1. In ARD select the name of the server you want to configure.
2. Use the options under the ‘Manage’ menu.
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State what file extension must be used in order for a file to be recognized as an auto server
setup file by Mac OS X Server
1. ‘.plist’ for the configuration file.
2. ‘.pass’ for the file containing the decryption password (optional).

Given a collection of application serial numbers and a remote computer, configure the
applications on the remote computer with the given serial numbers
1. Locate the files responsible for storing the serial numbers.
2. Include a copy of those files in your deployment, a good idea is to create a ‘.pkg’ file that

install those files as a postimaging action.

3. Alternatively you can create a postimaging script that updates the ‘.plist’ files with the serial

number through the us of the defaults CLI command.
Describe how a file should be created to distribute a password to allow Mac OS X server to
access an encrypted Auto Server Setup file
1. Create a file matching the name of the encrypted configuration file with ‘.pass’ extension.
2. Place this file in any folder named ‘Auto Server Setup’ located at the root level of any volume

available at the boot of a newly installed system.

Given one or more computers, apply system settings, such as static network values after a
system has been installed
1. Inside ARD application select the computer you want to change the settings for.
2. Click the ‘Manage > Send UNIX Command’ menu.
3. Enter the following ‘networksetup’ commands:
• $ sudo networksetup -setmanual “Ethernet” <IP address>

<netmask> <default route>
• $ sudo networksetup -setdnsservers “Ethernet” <dnsserver IP>
• $ sudo networksetup -setsearchdomain “Ethernet” <domainname>

4. Click ‘Send’ to apply the command.

Define the valid storage locations for saving auto configuration files

Any volume available (mounted) during the installation process can host in its root directory the
‘Auto Server Setup’ folder that may contain the configuration ‘.plist’ or the password ‘.pass’ files.
Given one or more remote computers create scripts to apply system configuration settings
and set machine variables after the remote computers have been images
1. Use the ‘systemsetup’ command inside the scripts.
2. Pack the scripts into one or more ‘.pkg.’ file that will selectively run according to filters to

diﬀerentiate the configuration in each computer.

3. Deploy the package files via ARD.
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List third-party solutions to configure multiple remote computers after they have been
imaged
1. Casper Suite by JAMF.
2. KACE systems management appliances.
3. FileWare suite.
4. LANDesk suite.
5. LANrev suite.

Given the Terminal application and a property list editor on a default installation of Mac OS
X Server, create launchd item to launch a service on demand
1. Place the script in /Library/Scripts.
2. Create a launchd property file that reference your script and include the KeepAlive key.
3. Place the ‘.plist’ file in a LaunchAgent folder.
4. Restart the computer or execute:

$ sudo launchctl load -w file.plist
List the conditions that can be set to restrict an auto server setup file to specific computers in
the order of precedence
1. Built-in hardware serial number of the server.
2. Ethernet (MAC) address of the first network port of the server.
3. IP address of the server.
4. Fully qualified DNS name of the server.
5. NONE of the above.

Create a launchd item to launch as service at the regular interval

Create a launchd configuration file with the StartInterval key configured.
Explain the function of byhost preferences and identify which computers they apply to
1. The ByHost preferences are set on a per-computer basis and by default apply only to a

specific computer.

2. You can find these preferences in every user’s home folder

“~/Library/Preferences/ByHost/”
3. The preferences files in the folder are tied to a specific computer based on a unique identifier

(UUID) included as part of the preferences file name.

Given launchctl on a default installation of Mac OS X Server, load a launchd job

$ sudo launchctl load -w file.plist
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Describe the underlying structure and format of Mac OS X Server’s property list architecture
1. Property list files come in two primary formats:
• XML formatted plain-text.
• XML binary (faster to load).

2. Preferences files are made up of Key/Values pairs.

Given the ARD Admin application on a default installation of Mac OS X Server and an
inactive ARD client on a default installation of Mac OS X, configure the ARD client to
activate the ARD agent using the kickstart tool from a remote machine

On the ARD Admin application choose File > Create Client Installer to create an
installer that can be used to set up and enable the Remote Management service on any client Mac.
List the tools included with Mac OS X that are capable of altering preferences lists files
1. Property List Editor.
2. Workgroup Manager.

Given a Mac OS X system and a script, configure the operating system to execute the script
every time a user logs in
1. Create a .plist file that refers to the script.
2. Pace it in the /Network/Library/LaunchAgent folder.

Describe the purpose, features and benefits of launchd and launchctl
1. The launchd process controls startup for all items in Mac OS X.
2. The launchd process looks to several specific folders for launchd property list configuration

files.

3. A Launch Agent is a process started in behalf of a user and is only allowed to be active

during the time the user is logged in the system.

4. Launch Daemons are processes automatically launched in behalf of the system and are

allowed to run any time the system is running.

5. The launchctl command force launchd to load your configuration files without need

to restart the computer.

Create a script that uses the systemsetup command to configure general system settings
including date, time, computer name and energy settings
1. $ systemsetup -setdate dd:mm:YY
2. $ systemsetup -settime hh:mm:ss
3. $ systemsetup -setcomputername “Marc’s Computer”
4. $ systemsetup -setsleep “Never” (“Oﬀ” or <minutes>)
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List the valid locations for storing launchd items in a standard installation of Mac OS X

Launch Agents Folders:
1. ~/Library/LaunchAgents/
2. /Network/Library/LaunchAgents/
3. /Library/LaunchAgents/ (third-party agents for all users)
4. /System/Library /LaunchAgents/ (Apple-supplied agents for all users)

Launch Daemons:
1. /Library/LaunchDaemons/ (third-party daemons)
2. /System/Library/LaunchDaemons/ (Apple-supplied daemons)

Configure the network settings of the computer using the networksetup command
1. $ sudo networksetup -setmanual “Ethernet” <ipaddress> <netmask> <default_route>
2. $ sudo networksetup -setdnsserver “Ethernet” <dns server ip>
3. $ sudo networksetup -setsearchdomains “Ethernet” domainname.com

Enable ARD for a specific account using kickstart command

$ sudo /System/Library/CoreServices/RemoteManagement/ARDAgent.app/
Contents/Resources/kikstart -activate -configure -access -on users ladmin -privs -all -restart -agent -menu
List the common triggers launchd “understands” by default for launching jobs
1. StartOnMount
2. WatchPaths
3. QueueDirectories
4. StartIntervall
5. StartCalendarInterval

Configure computer settings using defaults

$ sudo defaults write <plist file> <key name> <key value>

List the common keys included in a launchd property list
1. KeepAlive
2. WorkingDirectory
3. EnvironmentVariables
4. UserName
5. StartOnMount

PAGE 44 OF 49

APPLE CERTIFIED SPECIALIST - DEPLOYMENT V10.6

MARCO AT MARCOMC DOT COM

Explain what a “login hook” is
1. A login hook (LoginHook) is a key of the loginwindow preferences list that permit to

hook a script to the execution of the user login via the loginwindow application.
2.
3.

$ sudo defaults write com.apple.loginwindow LoginHook /Library/Scripts/loginscript
$ sudo defaults write com.apple.loginwindow LogoutHook /Library/Scripts/logoutscript

Identify which Mac OS X command-line utility is used to configure general system settings

systemsetup
Identify the Mac OS X command-line utility that is used to configure network settings in
SystemPreferences

networksetup
State which Mac OS X command-line utility is used to enable ARD Remote Management for
a specific local administrator account

kickstart
Identify which Mac OS X command-line utility is the primary tool for reading and writing
directory system data

dscl
Identify which Mac OS X command-line utility should be used to bind a Mac OS X system to
an Active Directory service

dsconfigad
Identify which Mac OS X command-line utility should be used to bind a Mc OS X system to
an LDAP service

dsconfigldap
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System Maintenance
Given ARD and a number of Macintosh computers, configure ARD to monitor/track
hardware and software
1. Configure one Mac computer to act as ARD Task Server.
2. Configure the administrative Mac computer to use a remote Task Server.
3. Activate the remote management in each other Mac you want to monitor/track.
4. From the administrative computer open ARD and select the computers you want to

monitor.

5. Access the “Info” panel and select which data you want to monitor/track.

List available license and software tracking systems
1. Altins Asset Management Solution
2. Asset Trustee by FileWare
3. K2 by Sassafras
4. Recon Suite by JAMF

Define the following terms: Apple Remote Desktop, Task Server
1. ARD is the remote control, management, reporting and deployment tool for Mac OS X

systems.

2. ARD Task Server is designed to act as an intermediary between the Remote Desktop

administrator application and the Mac clients that are being managed.

Given a Mac OS X Server computer list all he currently available software updates provided
by Apple
1. Open the Server Admin application.
2. Select the server name from the list of available servers.
3. Select the ‘Software Update’ service from the list.
4. Click the ‘Updates’ button from the tool bar to list all the current software updates published

by Apple.

State how to configure a router to prevent Mac OS X computers on the local network from
accessing and downloading updates from Apple’s update servers

Block access to the domain name swscan.apple.com
State the default location where updates download from Apple are stored on a Software
Update server

/var/db/swupd
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State the preference file where you set the URL of the Software Update server to be
accessed for software updates

/Library/Preferences/com.apple.SoftwareUpdates
State what process on a Mac OS X Server computer is used to synchronize updates between
the server and Apple’s software update servers

swupd_syncd
Identify which process is used to provide the software update service on a Mac OS X Server
computer

httpd (executing as _softwareupdate user)
State which file should be modified to reconfigure the Software Update service on one Mac
OS X Server to retrieve updates from a second Mac OS X Server computer

/etc/swupd/swupd.plist

Set up a test Software Update Server to test distribution of updates provided by Apple
before enabling the updates on an organization’s primary software Update server
1. Configure a Mac OS X Server for the Software Update service with internet access.

Enable it to retrieve the software updates directly from Apple’s servers and enable all the
updates to ‘Available’ (or only the ones you want to test).

2. Configure a set of test Mac computers to retrieve their updates from the test server.
3. Configure the main Mac OS X Server for Software Update service to retrieve the list of

available updates from the test server (not from Apple’s servers).

4. Configure the production Mac computers to retrieve their updates from the main Mac OS

X Server with Software Update service so they will be served with only a limited selection of
software that have been previously tested.

Given a Mac OS X computer and a Mac OS X Server computer that is running the Software
Update service, configure the preferences on the client computer to use the specific software
Update service to access available updates
$ sudo defaults write /Library/Preferences/com.apple.SoftwareUpdate CatalogURL “http://
swupd.server.address:8088”
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Given a Mac OS X Server computer that is managing the preferences on one or more Mac
OS X computers and a Mac OS X Server computer that is running the Software Update
service, configure the client computers to use the given Software Update service to access
available updates
1. Open the Workgroup Manager application and authenticate as the directory administrator

in the Directory Server.

2. Select the computer on the group of computers you want to manage the Software Update

preferences for, from the accounts list.

3. Click the ‘Preferences’ button
4. Select the Software Update preference pane
5. Specify http://software.update.server:8088/index.catalog as “Software Update server to use”

Given a Mac OS X Server computer with the Software UPdate service not functioning
correctly troubleshoot the server so that the client computers are able to access and
download updates correctly
1. Ensure proper Software Update configuration in Server Admin: verify that the appropriate

updates are downloaded and enabled.

2. Verify you can access these URL from the the troubleshooted computer and from another

computer:

• http://swupd.server:8088/index.sucatalog
• http://swupd.server:8088/index-leopard.merged-1.sucatalog
• http://swupd.server:8088/index-leopard-snowleopard.merged-1.sucatalog

3. Check the server’s network configuration: make sure the firewall is not blocking 8088 port.
4. Check client’s configuration: make sure the CatalogURL key in

/Library/Preferences/com.apple.SoftwareUpdate.plist points to your
local Software Update server.
5. Make sure the Software Update server can access the main servers or another computer

running Software Update service.

6. Verify that the software update service is running on the server.
7. Check that the process responsible of the Software Update server are running in the Mac

OS X Server such swupd_sync and httpd (running as _softwareupdate user)
8. Rebuild the Software Update server:
• Stop the Software Update service.
• Delete all items inside the /etc/swupd and /var/db/swupd/html folders.
• Restart the Software Update service to rebuild the catalog and download again the

updates.
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Given a Mac OS X Server computer, configure the Software Update service to identify and
download software updates provided by the Software Update service running on another Mac
OS X Server computer
1. Edit the /etc/swupd/swupd.plist file manually.
2. Modify the <key>metaIndexURL</key> with the address of the Software Update

server:

<key>metaIndexURL</key>
<string>http://second.swupd.server:8088/catalogs.sucatalog</string>

Given ARD 3 application on a default installation of Mac OS X, configure an Apple Remote
Desktop task server
1. Open ARD 3 and select Remote Desktop > Preferences from the menu.
2. Click the ‘Task Server’ button.
3. Select ‘Use Task Server in this computer’ and check the box by ‘Allow remote connections to

this server’.

Given a deployment plan, modify the plan to incorporate steps to roll-back an update or
software release should issues be encountered
1. Manually locate and remove the problematic items or prepare an automatic script to deploy

via ARD.

2. Alternatively restore the system from your latest working system image.

Given a description for a target audience, create a policy permitting image modification

Use SIU to create modular system images, so every time a system receive an update it’s possible to
include this update in the workflow to generate the modular system image.
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